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Introduction 

What is the National Transit Database? 

The National Transit Database (NTD) is the Federal Transit Administration's (FTA's) primary national database for statistics 
on the transit industry. Recipients of FTA’s Urbanized Area Formula Program (§5307) and Other than Urbanized Area 
Formula Program (§5311) are required by statute to submit data to the NTD. The legislative requirement for the NTD is 
found in Title 49 U.S.C. 5335(a): 

SECTION 5335 NATIONALTRANSIT DATABASE 

(a) NATIONAL TRANSIT DATABASE — To help meet the needs of individual public transportation systems, the United 
States Government, State and local governments, and the public for information on which to base public transportation 
service planning, the Secretary of Transportation shall maintain a reporting system, using uniform categories to 
accumulate public transportation financial and operating information and using a uniform system of accounts. The 
reporting and uniform systems shall contain appropriate information to help any level of government make a public 
sector investment decision. The Secretary may request and receive appropriate information from any source. 

(b) REPORTING AND UNIFORM SYSTEMS — The Secretary may award a grant under section 5307 or 5311 only if 
the applicant and any person that will receive benefits directly from the grant, are subject to the reporting and uniform 
systems. 

The Safe, Accountable, Flexible, and Efficient Transportation Equity Act: A Legacy for Users (SAFETEA-LU) amended the 
National Transit Database provisions to establish annual reporting requirements for recipients and beneficiaries of §5311 
Other than Urbanized Area formula grants while maintaining existing NTD annual reporting requirements for recipients and 
beneficiaries of Urbanized Area Formula funds. Additionally, Title 49 U.S.C. 5311(b) (4) was amended to provide certain 
specifications of the NTD reporting requirements for §5311 grant recipients: 

(4) DATA COLLECTION – Each recipient under this section shall submit an annual report to the Secretary containing 
information on capital investment, operations, and service provided with funds received under this section, including –  

(A) total annual revenue; 

(B) sources of revenue; 

(C) total annual operating costs; 

(D) total annual capital costs; 

(E) fleet size and type, and related facilities; 

(F) revenue vehicle miles; and 

(G) ridership. 

NTD began collecting rural transit data in 2006 using a model that was developed in consultation with States. The 2007 
reporting system was updated to reflect the above data requirements. In keeping with the sentiments of the States, and the 
intent of Congress, the NTD offers streamlined and reduced reporting requirements for rural reporting relative to the NTD 
requirements for urbanized area reporting.  

Changes in 2008 Reporting 

The Rural Reporting Manual incorporates several changes and clarifications for the 2008 report year. 

Changes 
Internet Reporting incorporates the following: 

• The Issues tab is now functional. 

Tribal Transit Grant recipients that were awarded planning only funding are not required to file a report. However, FTA would 
like grantees to complete the State Agency Identification form (RU-10) with current information.  

The Rural General Public Transit Service form (RU-20) incorporates the following: 

• Existing subrecipient contact information is pre-filled with 2007 data  

• Service area information now includes reservation and no longer includes community  

• Existing subrecipient revenue vehicle fleet information is pre-filled with 2007 data 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G172
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G167
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G167
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• Revenue vehicle information for vehicle type now includes sport utility vehicle (SV) and over-the-road bus (BR). 

Clarifications 
The State must file a Rural General Public Transit Service form (RU-20) for all subrecipients that received a Nine or Fewer 
Vehicles Waiver for the current NTD Annual Report.  

The RU-20 form instructions include clarification of: 

• Demand response (DR) mode reporting for subscription and coordinated / sponsored services 

• Intercity bus mode reporting 

• Indian Tribe reporting 

• Expense and revenue reporting for operations and capital projects 

• Counties served reporting. 

Who Reports 

States receiving §5311 funds must report to NTD. For purposes of the NTD, the District of Columbia, Puerto Rico, Virgin 
Islands, American Samoa, Guam, and the Northern Mariana Islands are treated as States (although the District of Columbia 
and the Virgin Islands do not receive any §5311 grants). The State agency, typically the State Department of Transportation 
administering the FTA Formula Program for Other than Urbanized Areas (§5311) are responsible for collecting and providing 
data regarding each §5311 subrecipient in the State. 

SAFETEA-LU defines recipients and subrecipients as follows: 

• Recipients are a State or Indian Tribe that receives a §5311 grant directly from the Federal government 

• Subrecipients are a State or local governmental authority, a nonprofit organization, or an operator of public 
transportation or intercity bus service that receives §5311 funds indirectly through a recipient. 

Indian Tribes that receive §5311 grant funds directly from the Federal government (Tribal Transit Grants) must report directly 
to the NTD. Tribal Transit Grantees should report in the year after application for the grant, or in the year that grant funds are 
first disbursed, whichever is sooner. For simplicity, FTA will treat the year of the award of the grant as the year of application 
of the grant. Indian Tribes that do not have subrecipients should consider themselves to be both the recipient and the 
subrecipient for purposes of the NTD.  

Tribal Transit Grant Recipients that have only received planning grants for $50,000 or less do not need to complete a report. 
Please note that as provided by law, the requirement for NTD reporting is triggered by the award of a Tribal Transit grant, 
and not by the actual disbursement of the grant funds from FTA to the Tribal Transit Grant Recipient. For example, a Tribe 
that was awarded a $300,000 grant for system enhancement in 2007 would be required to report to the NTD in 2008, even if 
disbursement of the grant does not occur until 2009. 

There are three major categories of subrecipients: 
1. Regular Public Transit Service Providers — most subrecipients are in this category. States should provide a complete 

report of all transit operations for these subrecipients on the RU-20 form. State Department of Transportation should 
report Indian Tribes that are not direct recipients of Tribal Transit Grants as regular public transit service providers.  

2. Tribal Transit Recipients — Indian Tribes that are direct recipients of Tribal Transit Grants from FTA typically do not 
have any subrecipients. They should provide a complete report of all transit operations for themselves on the RU-20 
form as if they were the sole recipient of the grant.  

3. Intercity Bus Providers — SAFETEA-LU amended 49 USC 5311(f) to require States to set aside 15 percent of the 
annual §5311 apportionment for intercity bus providers, unless the Governor certifies that the intercity bus needs of the 
State are being adequately met. Since many States would not be able to provide a complete report of all transit 
operations for these subrecipients, FTA has established a special RU-20 form for the State to complete on behalf of 
these subrecipients. States use this form only for subrecipients of the intercity bus set-aside under 49 USC 5311(f).  

The State or directly-reporting Indian Tribe completes the RU-10 form and completes a RU-20 form for each subrecipient. 
The Internet Reporting System generates almost all of the data on the Statewide Summary form (RU-30) form from the data 
provided on the RU-20 forms. The State also completes the remaining portion of the RU-30. Directly-reporting Indian Tribes 
do not complete any additional information.  
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• Earthquakes 

• Fires 

• Floods  

• Hurricanes 

• Officially declared emergencies. 

FTA has also historically granted waivers for the first year in which a direct recipient has been required to report to the NTD, 
and only for the first year. FTA has historically not considered “unreasonable expense and inconvenience” to cover issues 
related to the loss of personnel or the loss of records.  

Submit waiver requests in writing through the e-File tab of the Internet Reporting System. The Director of the Transit Unit of 
the State or the directly-reporting Indian Tribe should sign waiver requests. Describe the event that prevents fulfilling the 
reporting requirements.  

FTA reviews and approves these requests on a case-by-case basis. FTA will grant or deny your request, in writing, via the e-
File tab.  

When to Report 

Submit the NTD Rural Report within 120 days of the close of the State’s or directly-reporting Indian Tribe’s fiscal year 
according to the schedule in the following exhibit.  
 

Exhibit 1 – Reporting Timeline for Rural NTD  
State or Indian Tribe’s Fiscal Year End Jan. 1 - June 30  July 1 - Sept. 30  Oct. 1 - Dec. 31 
Submission 
Report Due Date    October 31  January 30  April 30 
Filing Extension Deadline   August 29  November 28  February 27 
Waiver Request Deadlines   August 29  November 28  February 27 
Closeout Process 
Last Date to Receive Report Revisions March 16  May 1   July 2 
Report Closeout*    March 31   May 15   July 20 

 

The first reports will be due on October 31, 2008, for those States or directly-reporting Indian Tribes with fiscal years ending 
between January 1 and June 30, 2008; on January 30, 2009, for those States or directly-reporting Indian Tribes with fiscal 
years ending between July 1 and September 30, 2008; and April 30, 2009, for those States or directly-reporting Indian Tribes 
with fiscal years ending between October 1 and December 31, 2008.  

States or directly-reporting Indian Tribes may collect the data from the rural providers according to their own schedules and 
reporting periods as long as the rural providers are reporting for the current NTD report year. Data must cover a consecutive 
twelve month period and the reporting deadline must be met. For example, if the State fiscal year end is June 30, 2008 but a 
subrecipient has a fiscal year end December 31, 2008, use the subrecipient data for the most recent 12-month period that 
would be included in your State’s annual report for the fiscal year. 

Reminder Notices 
FTA sends each State or directly-reporting Indian Tribe a reminder 30 days prior to the NTD Rural report due date. If FTA 
does not receive your report within 15 calendar days after the due date, and there is no request for a reporting waiver, FTA 
sends a letter to the State or directly-reporting Indian Tribe Director of the Transit Unit requesting that the report be 
submitted within 15 days.  

Reporting Period Extension  
If the State or directly-reporting Indian Tribe needs additional time to collect, to enter and to submit data from all 
subrecipients they may request a 30-day extension. Submit an extension request in writing through the e-File tab of the 
Internet Reporting System. The Director of the Transit Unit of the State or the directly-reporting Indian Tribe should sign the 
extension request. Describe the situation and provide a timeframe when the State or directly-reporting Indian Tribe will 
submit their report. 
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FTA reviews and approves these requests on a case-by-case basis. FTA will grant or deny your request, in writing, via the e-
File tab.  

The NTD Rule (49 CFR Part 630) provides for only a single 30-day extension per report year. A request for an additional 
extension beyond 30 days would constitute a request for a waiver from the reporting requirements, and such a request will 
be evaluated by FTA according the criteria for requesting waivers.  

How to Report 

General Formatting Rules  
Follow these rules when reporting data: 

• Round all financial data to the nearest dollar 

• Report data as whole numbers 

• Use four digits for year entries. 

Accrual Accounting 
All financial data in the NTD Rural Report must follow accrual accounting principles. Under accrual accounting: 

• Record revenues when earned, regardless of whether or not receipt of the revenue takes place in the same reporting 
period 

• Record expenditures as soon as they result in liabilities for benefits received, regardless of whether or not payment of 
the expenditure takes place in the same reporting period. 

If a cash basis or encumbrance basis accounting system is used, make worksheet adjustments to record the data on an 
accrual basis. 

The following example demonstrates the use of accrual accounting for both capital asset and operating expense reporting. 
 

Example 2 — Accrual Accounting  
Capital Projects 
Hamlet Transit applies to the State to purchase two buses in fiscal year (FY) 2008 at a projected cost of $440,000, or $220,000 
each. FTA approves the State’s program of projects, which includes the project for Hamlet Transit, and awards FY 2008 Other 
than Urbanized Formula Program funds based on an 80/20 split for the Federal / non-Federal match. The City of Hamlet pays 
the non-Federal match. 
Hamlet Transit takes delivery and accepts only one of the buses by the end of FY 2008. 
Solution: Report the Federal share of the bus = $176,000 (1 × $220,000 × 80%) on line 16c, FTA Other than Urbanized Area 
Program funds (§5311), column a; and the non-Federal share of the bus = $44,000 (1 × $220,000 × 20%) on line 14, Local 
capital assistance, column a. 
Operating Expense 
Hamlet Transit pays its employees twice a month, on the 15th and last day of the month, approximately 15 days after the end of 
the work period. Assume Hamlet has a fiscal year end date of December 31. If, an employee works from December 16 to 
December 31, he receives his pay on January 15 of the next fiscal year. The liability to pay for the work from December 15 to 
December 31 was incurred as of December 31 (current fiscal year), even though the employee did not receive his pay due until 
2 weeks later (next fiscal year). The expense is reported in the current NTD report under accrual accounting since Hamlet is 
“liable” to pay the employee, even though the employee did not receive actual payment until the next fiscal year. 
Similarly, the employee earns fringe benefits such as vacation and sick leave, as he works each pay period. This is when the 
liability is incurred. However, the employee may not use the earned benefits until the next fiscal year. Under accrual accounting, 
Hamlet incurred the liability during the current fiscal year when the employee worked and accrued the leave time 
Both the labor and fringe benefit costs are operating expenses reported on line 05, Total Operating Expense, column a. 

Grants 
Most Federal, State and local grants are earned on a reimbursement basis. Generally, transit agencies will report grant funds 
only if an expenditure occurs, i.e., when the grant funds are earned. Do not report the total amount of funding in an approved 
grant application, only the grant funds earned from an incurred expenditure during the period.  

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G5
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Mode  
NTD gathers information based on transit mode. Transit agencies operate one or more modes of transit service. A mode is a 
system for carrying transit passengers described by specific right-of-way, technology and operational features.  

The glossary contains the detailed NTD modal definitions. There is also a discussion of deviated bus (MB) service, which 
has characteristics of both MB and DR modes. 

The NTD Rural reporting system uses the following modes of public transit service: 
Bus (MB)  

 
The most prevalent mode in the country, 
and is powered by a motor and fuel 
contained within the vehicle. Includes both 
fixed-route and deviated-fixed-route 
services provided by vehicles with an 
onboard motor and onboard fuel.  

Demand Response (DR)  

 
Scheduled in response to calls from 
passengers. Passengers with similar 
origins and destinations are often 
scheduled to ride the same vehicle. Many 
transit systems operate DR service to meet 
the Federal ADA requirements, and 
expenses and passenger trips are 
reportable for DR. Includes door-to door 
and curb-to-curb services provided in 
response to specific customer requests. DR 
services are characterized by being a 
shared ride service to individuals.  

Intercity Bus (IB) 

 
Regularly scheduled public service using 
an over-the-road bus that operates with 
limited stops between two urbanized 
areas or connecting rural areas to an 
urbanized area. The IB mode is only 
used by private intercity bus providers 
that are subrecipients of the intercity bus 
set-aside under 49 USC 5311(f). 

Vanpool (VP)  

 
A commuting service operating under pre-
arranged schedules for previously formed 
groups of riders in vans. 

 Other  
If none of the choices fits your agency, 
select the category: Other. Internet 
Reporting will display a box for you to 
describe the other mode. 

Route-Deviated Service 
Route-deviated service has operating characteristics of both MB and DR 
modes. Route-deviated service operates as a conventional bus route, but 
permits the bus to deviate from the route and serve destinations within a 
prescribed distance (e.g., ¾ mile). Report this service as bus mode.  

 
 

 

http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G266
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G67
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G114
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G215a
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G510
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G405


http://www.ntdprogram.gov/
http://www.ntdprogram.gov/ntdprogram/Glossary.htm#G408
http://www.ntdprogram.gov/
http://www.ntdprogram.gov/ntdprogram/feedback.jsp
http://www.ntdprogram.gov/ntdprogram/reference.htm
http://www.ntdprogram.gov/ntdprogram/reference.htm
http://www.ntdprogram.gov/ntdprogram/data.htm


2008 Rural Reporting Manual 

Internet Reporting - 8 

Internet Reporting 

Overview 

States or directly-reporting Indian Tribes must use the National Transit Database (NTD) Internet Reporting system to provide 
their data to the Federal Transit Administration (FTA). NTD Internet Reporting is the online means to enter, save, review and 
revise data, and submit reports. It provides for timely and accurate reporting as all tasks and requirements for the NTD can 
be fulfilled via this system. 

This section provides Internet Reporting information for the NTD Rural report.  

What Has Changed from Prior Year 
The Issues tab is now functional. 

Internet Reporting System Security 
FTA implemented numerous measures to ensure that all data entered into the Internet Reporting system are safe and 
available only to those with proper access. A firewall secures the NTD servers and network. The website operates the 
secured web protocol, https, and the entire site is password-protected. Additionally, multiple server and database protection 
layers protect the database files. 

Detailed Instructions 

Accessing the NTD Rural Internet Reporting System 
Access the NTD Rural Internet Reporting System is accessed through the NTD Homepage. 

To access Internet Reporting:  
1. Connect with the Internet via your Internet service provider (ISP) 
2. Access the NTD Project website (www.ntdprogram.gov) 
3. Click on the Internet Reporting Login link 
4. Enter your User Name (Rural identification number) and Password. 

Connecting to the Internet 
Use your Internet service provider to connect to the Internet. NTD Internet Reporting requires the Internet Explorer web 
browser that is at least a 6.0 version. 

If you don’t have the latest version of Internet Explorer, go to Microsoft.com to download the latest version free of charge. 

Verifying Your Internet Browser Settings 
Verify that your browser is set to check for newer versions of stored pages with each visit to the page. 

In Internet Explorer, this is done by accessing Tools / Internet Options / General / Temporary Internet Files Settings / Every 
Visit to Page. 

http://www.ntdprogram.gov/
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The National Transit Database Website 

 
The NTD Homepage offers the following information and data for reporters and others interested in the NTD: 
• Internet Reporting Login link. 
• What is the NTD?: An overview of the NTD program, milestones in transit history, how to obtain an NTD ID number and 

an overview of the NTD reporting forms. 

Reporting Manuals 
• Annual Reporting: Access to .html and .pdf versions of the current Annual Reporting Manual, an overview of reporting 

changes and highlights, reporting manual archives, etc. 
• Monthly Reporting: Access to .html and .pdf versions of the current Monthly Reporting Manual, an overview of the 

reporting changes and highlights, reporting manual archives, etc. 
• Safety and Security Reporting: Access to .html and .pdf versions of the current Safety and Security Reporting Manual, 

Newsletters, Safety and Security FAQs, an overview of reporting changes and highlights, reporting manual archives, 
etc. 

• Rural Reporting: Access to .html and .pdf versions of the current Rural Reporting Manual, an overview of reporting 
changes and highlights, reporting manual archives, etc. 

Data, Publications and Reference Materials 
• NTD Glossary: HTML version of the NTD Glossary of transit terms. 
• NTD Reference Materials: NTD reference materials such as the Uniform System of Accounts, FTA Circulars and 

Federal Register Notices. 
• Access NTD Data: HTML and downloadable .pdf publications, including the Data Tables, Profiles, National Transit 

Summaries and Trends, as well as Annual, Monthly and Historical databases and other data products. 

NTD Resources 
• FTA / NTD Presentations, Announcements and Updates: FTA / NTD presentations, new and useful information, 

interim updates to reporting requirements, etc. 
• NTD Feedback: The mailing address, telephone number and fax number for the NTD Project site as well as an 

opportunity to provide comments or suggestions regarding the NTD Program.  
• Seminars and Training: NTD Reporting Seminars and In-house Training information and registration. 
• Transit Agency Listing by Region and External Links: Contact information for transit agencies reporting to the NTD. 

Links to:  
• Federal Transit Administration (FTA) 
• FTA Safety and Security Office 
• U. S. Department of Transportation (USDOT) 
• National Transit Library 
• American Public Transportation Association (APTA) 

Internet Reporting - 9 
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• Bureau of Transportation Statistics 
• Accessibility. 

Accessing the NTD Report  
Clicking the Internet Reporting Login link will open the Internet Reporting Login page. Enter your user name and password 
to gain access to NTD Rural Reporting.  

 

Levels of Access 
Internet Reporting provides four levels of access to the Rural Report:  
1. Director of Transit Unit access: Edit forms (data entry), submit extension requests, and submit report  
2. NTD Contact Person access: Edit forms (data entry) and submit report (administrator)  
3. Editor access: Edit forms (data entry), cannot submit report  
4. Viewer access: View only including forms, issues, notes and correspondence. 

The user name determines the system access level. The first three characters of the user name define the access level and 
the last four digits represent the State’s or directly-reporting Indian Tribe’s NTD ID. There are four types of user names 
corresponding to the four access levels available within the NTD Report: 

 State Indian Tribe 

1. Director of Transit Unit  DIR#R## DIRTR## 

2. Rural Contact  RUR#R## RURTR## 

3. Editor EDT#R## EDTTR## 

4. Viewer VWR#R## VWRTR## 

FTA e-mails each State or directly-reporting Indian Tribe this set of user names with a password for each. States or directly-
reporting Indian Tribes determine access within their organizations and distribute user names and passwords accordingly. 

A user can change his or her password at any time. Refer to Sys Admin: Changing Your Password for additional information 
on this topic. Passwords expire every ninety days.  

NTD Reporting Structure 
NTD Rural Reporting includes the following tabs: 
• Home: The starting point when entering the NTD Rural Report. It displays the reporter’s NTD analyst information and 

any project related announcements. 

Internet Reporting - 10 
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• e-File: A listing of all general correspondence and current year report stages. This screen provides a means for a State 

or directly-reporting Indian Tribe to view the text of existing general correspondence, and to add documents via a file 
attachment. Submit all correspondence and documents to NTD from this screen. 

• Annual: A listing of the forms and provides access to the specific forms necessary to complete the NTD Rural Report. It 
is from this screen that the State or directly-reporting Indian Tribe submits the NTD Rural Report. 

• Notes: Displays all the form notes added to the State’s or directly-reporting Indian Tribe’s report. Internet Reporting 
allows the user to create form notes to provide additional information applicable to the overall form / report. 

• Issues: Displays all the Issues generated for the State’s or directly-reporting Indian Tribe’s report. Issues highlight 
potential problems with specific data items (specific data which fall out of a typical range of values) and are generated 
each time the State or directly-reporting Indian Tribe saves submits the NTD Rural Report. To correct an Issue, the 
State or directly-reporting Indian Tribe may either change the data item on the appropriate form or attach a Comment to 
the individual Issue and explain. Use this screen to review the Issues for entire report (form by form) prior to submitting 
your NTD Rural Report.  

• Reports: Print and export reports. The user can print each form (report) without altering print settings to fit a form on the 
page.  

• Communications: The Communications screen lists a record of the report submissions the agency has made to NTD, 
including any comments from the State or directly-reporting Indian Tribe and the review status of the report. 

• Sys Admin: Change NTD passwords — Director of Transit Unit, NTD Contact Person, Editor and Viewer. You may only 
change your password. If you need assistance, contact your NTD analyst. The Sys Admin screen is also used to add 
new subrecipients, activate a subrecipient who was deactivated, and deactivate a subrecipient who is no longer 
providing service to the State. 
Managing Subrecipient RU-20 forms is also done via the Sys Admin tab. 

• Help: The Help screen provides a link to an online version of the NTD Rural Reporting Manual and Glossary. 

 

Home: The NTD Rural Report Homepage 
After completing the Login process you will be taken to the Annual Report Home page. Click the Home tab near the top of 
any screen to return to the Home tab from another area. 

When accessing the Home tab, please take note of the Announcements section. There you will find a listing of FTA 
announcements and the Rules of Behavior document. All users of NTD’s Internet Reporting system are required to sign the 
Rules of Behavior document annually and return it to the NTD Project site. By clicking the Rules of Behavior link within the 
Announcement section, users will find a link to the Rules of Behavior PDF for downloading, printing and has instructions 
for signing and returning the document.  

Internet Reporting - 11 
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e-File: Communicating with FTA 
The e-File tab provides a centralized area in which to compose, organize and track correspondence with the NTD program. 
The e-File screen displays the status of your report and any correspondence between you and the NTD including waivers 
and filing extensions. Click on the e-File tab to open the e-File screen.  

Tracking Transactions  
• General correspondence is organized by sender: 

• Reporting agency 
• NTD program staff. 

• The status or phase (approved, denied, etc.) of the process for each correspondence item is indicated under the Status 
heading by correspondence type.  

E-mail responses are sent to the State or Indian Tribe following requests through the e-File system. Examples of letters sent 
from FTA to States or Indian Tribes are: 
• Waiver approvals 
• Extension approvals 
• Close Out correspondence 

The e-File tab is between the Home tab and the Annual tab. The e-File Summary screen provides a snapshot of the status 
of the NTD Annual report:  
• Report stage 
• Waivers 
• Extensions 
• Other agency requests. 

Attaching Correspondence 
Attach all correspondence under the e-File tab. To attach the written 
request select the Letter Attachment radio button, then select the 
Browse button. A Windows Dialog box will appear. The appearance of 
the window may be different based on the operating system (Windows 
Vista, XP, NT, 2000, 95/98, Apple Mac, etc.) being used. Navigate to 
the directory in which your file is stored and click Open. The file name 
will appear in the text area to the left of the Browse button. 

Report Stage 
The NTD Rural Reporting System incorporates several stages of report 
status: 
• Working Data: The State or directly-reporting Indian Tribe is able to enter and edit data only when the report is in 

Working Data status. Prior to submission, the report is in Working Data status.  
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• Original Submission: After completing and saving each form, the State or directly-reporting Indian Tribe submits the 

report to FTA by clicking on the Submit button on the Annual tab. After submitting the report, the report is in Original 
Submission status. The State or directly-reporting Indian Tribe or FTA may review the data review at any time. The 
State or directly-reporting Indian Tribe cannot alter any data in Original Submission status. 

• Submission Revision: After review of the submission by the analyst, the report is available in Working Data status 
again for further revision by the reporting State or directly-reporting Indian Tribe. After revising and saving forms in 
Working Data status, the State or directly-reporting Indian Tribe submits a revised report to FTA by clicking on the 
Submit button on the Annual tab. The data is then frozen in sequentially numbered Submission Revision status. 

• Closeout: Closeout status is the final report status. 

 

 

Forms: Providing Data to the NTD 
Click on the Annual tab to view the Forms Summary screen.  

The Forms Summary screen provides links to the forms your agency will complete for NTD Rural Reporting.  

Initially, the Forms Summary screen provides access to the State Agency Identification form (RU-10). The State Summary 
form (RU-30) and Add Form button will be viewable after submitting the RU-10. The Forms Summary screen allows the 
State to add a Rural General Public Transit Service form (RU-20) after a new subrecipient is added and assigned a 
subrecipient identification number via the Sys Admin tab.  

To add an RU-20 form, click on the Add Form button at the bottom of the screen. Then select RU-20 form from the Drop-
Down menu. Next select the subrecipient from the Drop-Down menu. The new subrecipient RU-20 form will appear on the 
Forms Summary screen highlighted in yellow.  
All form-by-form instructions and reporting details are in the form specific sections of this manual. The Forms Summary 
screen provides access to the required forms for your State or directly-reporting Indian Tribe. For each form, the Forms 
Summary screen identifies the update user and update date.  

Submitting Your Report 
To submit your report to the NTD, upon completing the required NTD Rural forms and reviewing and saving the RU-30, 
return to the Annual tab, scroll to the bottom of the page and click the Submit Report button. 

 

Notes: Providing Additional Information 
Click on the Notes tab to open the Notes Summary screen. The NTD Rural Reporting System allows the State or directly-
reporting Indian Tribe to create form notes for additional information applicable to the overall form. 

Creating a Form Note 
To create a form note click on the Add Form Note link at the top right of the form you are editing or viewing. Internet 
Reporting will take you to the Notes screen for the specific form. Internet Reporting will pre-fill the form type and subrecipient 
(if applicable) for which the note is created. The State or directly-reporting Indian Tribe completes the note comment. 

To save a form note, click on the Save button at the bottom of the screen. To return to the form being edited without saving 
the note, click on the Cancel button. 
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Reviewing Notes 
Click on the Notes tab to view the Notes Summary screen. You can review the notes associated with a specific form or all 
notes for the report. While working in a form, click on the Notes tab to access the Notes screen for the form. Internet 
Reporting displays the form name just beneath the tabs. 

Editing Notes 
You can edit Notes only in the Working Data stage. Click on the Edit Note link in the far right column on the Notes screen. 
Once the State or directly-reporting Indian Tribe submits the NTD Rural Report, Internet Reporting prevents any editing of 
the notes.  

Printing Form Notes 
Form notes are printed as part of each form’s report that is generated using the Print button at the bottom of each form. 

 

Issues: Validating Data 
The Issues screen, accessed by clicking the Issues tab, highlights potential problems with specific data items identified 
through the NTD validation process. The NTD validation process ensures that NTD reporting requirements are met. 

In support of the NTD validation process an NTD analyst is assigned to each transit agency. NTD analysts are available to 
assist State or directly-reporting Indian Tribe personnel and may be contacted at the NTD Project Office. Refer to Exhibit 2 in 
the Introduction section of this manual for NTD contact information. 

 

Reports: Viewing, Printing, and Exporting Reports to Assist in Preparing the NTD Report  
Click on the Reports tab to display the Reports screen. This screen provides access to the Revenue Vehicle Inventory 
Report, generated off of the combined RU-20 vehicle data, and is available to assist you in preparing your NTD report. 

To open a report click the corresponding link on the Reports screen. 

All Form Notes Report 
Click on the All Form Notes Report link to print all of the form notes associated with the NTD Rural report viewed on the 
Notes screen. 

Printing a Form Report from a Form Screen 
Click on the Print button at the bottom of the form screen to display the report in Adobe Acrobat Viewer. Click the Print 
button in the upper left corner of the viewer. Then click the Okay button on the resulting Print window. 
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Communications Summary: Viewing a History of Correspondence with NTD 
The Communications tab gives States or directly-reporting Indian Tribes a centralized area in which to view past 
correspondence with the NTD program. States or directly-reporting Indian Tribes can view correspondence by 
communication types. 

 

Sys Admin Tab: Changing Passwords, Adding or Deactivating Subrecipients 
The Sys Admin screen provides the ability to change your NTD password, as well as add, activate and deactivate a 
subrecipient. 

Changing Your NTD Password 
FTA assigns each NTD user a unique temporary password. With the launch of the 2008 Reporting software, you may login 
to NTD Reporting one time using this assigned password. Internet Reporting will prompt you to change your password at 
that time. Users can change passwords at any time by clicking on the Sys Admin tab. Follow the instructions for creating 
new passwords: 
• Passwords are a minimum of eight characters and be a combination of upper and lower case letters and numbers. Do 

not use dictionary words. 
• Change passwords at least every 90 days. Do not repeat passwords. NTD will change any compromised passwords 

immediately.  

 

Adding a Subrecipient 
To add a new Subrecipient that was not included in the previous year’s report, click on the Add Subrecipient link on the Sys 
Admin tab. On the Add Subrecipient screen, enter the Subrecipient name on line 01, select the type of recipient (Tribal or 
non-Tribal) and click Save to create new subrecipient ID. You will be taken back to the Forms Summary screen. Click the 
Add Form button to generate a RU-20 form and select the new subrecipient ID from the Drop-Down. Click the Generate 
Form button and the new subrecipient’s RU-20 form will appear highlighted in yellow. 
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Activating a Subrecipient 
To activate a Subrecipient that was included in an earlier report year, and was subsequently deactivated and not included in 
last year’s report, click on the Activate Subrecipient link on the Sys Admin tab. On the Activate Subrecipient screen, 
select the subrecipient’s name from the Drop-Down and click Update to activate the Subrecipient ID. Click the Save button, 
and you will be taken back to the Forms Summary screen. Click the Add Form button to generate a RU-20 form and select 
the activated subrecipient ID from the Drop-Down. Click the Generate Form button and the activated subrecipient’s RU-20 
form will appear highlighted in yellow. 

 

Deactivating a Subrecipient 
To deactivate a Subrecipient who reported in the previous year’s report but will not be included in the current year’s report, 
click on the Deactivate Subrecipient link on the Sys Admin tab. On the Deactivate Subrecipient screen, select the 
Subrecipient name from the Drop-Down on line 01 and click Update to deactivate them. If a RU-20 form was created and 
data entered for the subrecipient, it will be deleted and all data will be lost when the subrecipient is deactivated. This data 
cannot be activated or retrieved once it has been lost. 

Note: To reactivate a subrecipient that was deactivated in the current report year in error do not use the Subrecipient 
Management Tool. Contact your Analyst to reactivate a Subrecipient. 

 

 

Help: Obtaining More Information 
Click on the Help tab to open the Help screen. The Help screen provides access to the 2008 Rural Reporting Manual for 
additional help in completing the appropriate forms. The Help screen displays the table of contents for the Rural Reporting 
Manual with links to each section of the manual. 
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Tips for Using Internet Reporting 

Navigating Between Screens 
Do not use the browser Back and Forward buttons to navigate between screens. Instead, use the Internet Reporting system 
buttons, tabs and links.  

Saving a Form 
Use the Save button provided at the bottom of each form. When entering information into a form we strongly recommend 
that you save the form frequently. This will prevent the loss of data if your Internet connection is unexpectedly lost. Also, 
Internet Reporting has an automatic time-out feature which will log you off of the system after a period of inactivity. We 
strongly recommend that you save your work every 15 minutes. Otherwise, there is a risk that the next action you take on the 
system will result in the closure of the screen displayed in your browser and the loss of any data that you had not saved. 

Printing 
For trouble-shooting information refer to the Announcement section of the Home tab. 

Downloading the Adobe Acrobat Viewer for Forms 
In order to facilitate viewing and printing forms Internet Reporting utilizes the Adobe Acrobat downloadable viewer. Clicking 
the Print button on a form page will display a prompt to download the Adobe Acrobat Viewer, if it is not already installed. 
This download occurs only once and is necessary to view or print a report. 

To Print a Form Report from a Form Screen 
Click on the Print button at the bottom of the form screen to display the report in the Adobe Acrobat Viewer. Click the Print 
button  in the upper left corner of the viewer. Then click the Okay button on the resulting Print window. 
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